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CHAPTER 1

Introduction

Cantor is the front end for Ratings Central. Cantor allows you to easily submit
results and corrections to Ratings Central. You can see all the results and ratings
on the Ratings Central website at www.ratingscentral.com.

The only documentation for Cantor is this manual—there is no Help. You
will probably want to print this manual (double-sided) and place it in a three-ring
binder. If you read this manual, you will find Cantor to be very easy to use. Chap-
ter 2 on page 17 contains an overview in the form of a tutorial. The following chap-
ters of the manual are organized around each of the item’s in Cantor’s main menu.
These are followed by chapters on Cantor’s main window and club browser. Then
come chapters on unrated players, submitting events, and mistakes and errors.
The appendices cover Georg Cantor, screen resolution and font size, detailed in-
formation on the user interface, how Cantor finds the database folder, and crashes
and bugs.

1. Installation and Files

Cantor runs on Windows 8.1, 8, 7, Vista, XP, 2000, Server 2008, Server 2003.
Any computer hardware should work. You should also be able to run it on a Mac
or Linux using Wine or CrossOver. To submit results to Ratings Central, you will
need a connection to the Internet (see Section 3 on page 28 for more information).
You do not need to be connected to the Internet while you are entering results into
Cantor. So, you could enter the results at your club and then submit the results
later.

The installation program (e.g., Cantor_9.10_Setup.exe) creates a pro-
gram folder (e.g., C:\Program Files (x86)\RatingsCentral\Cantor) and places
the executable (Cantor.exe), User’s Manual (Cantor.pdf), sample rating list
(SampleRatingList.csv), sample club list (SampleClubList.csv), license file
(License.txt), OpenSSL files (libeay32.dll, ssleay32.dll; these files are only needed if
you check the ::Cantor > Set Up Internet > Email > Use TLS check box), read-me file
(ReadMe.txt), and a file detailing the changes in each version (VersionHistory.txt)
in the program folder. It adds Cantor and the User’s Manual to the “Start” menu
and optionally to the desktop. That’s all that the installation program does.

Note that the sample rating list and club list files are just samples—they do
not contain real players or clubs. Their only purpose is to let you work through the
overview section. Do not use them when running a real event that you will submit
to Ratings Central.
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14 1. INTRODUCTION

When you start Cantor, it will create the following set of database files in the
database folder: Club.nx1, Configuration.nx1, Event.nx1, Player.nx1, RatingList.
nx1, Result.nx1, and Submission.nx1. It will also create an nxTrans.cfg file.

The nxTrans.cfg file is used by the database library that Cantor uses, but the
file is not essential. If it is erased, it will be recreated.

The Club.nx1 and RatingList.nx1 files only contain the data from whatever club
list and rating list that you’ve imported. Also, it is possible to keep these two files
in a different folder than the other database files (see Section 2.2 on page 28).

The remaining five files with the nx1 extension contain the information for all
the events, players, and results. They are interdependent, so you should treat them
as a group. Be sure to make backup copies of them each time that you use Cantor,
and keep the copies in a safe place.

The location of the database folder is controlled by the shortcut that you use
to start Cantor. The shortcuts that the installer creates will put this folder in your
app data folder, e.g., C:\Users\YourUserName\AppData\Roaming\RatingsCentral\
Cantor. Note that the default location of the database folder has been different in
different versions of Cantor. See Appendix D on page 83 for how to tell Cantor
where your database folder is.

1.1. Upgrading. The format of the database files in a new major version of
Cantor will be different than in previous versions. However, the file format will not
change in a minor version release. You do not need to uninstall a previous version
when installing a new version (this applies to both major and minor versions). By
default, the installation program will install a new version so that it replaces an
older version. But, please make sure that your shortcuts still point to the location
of your database folder.

In general, Cantor can update database files from previous versions to the
current version’s format. It will do this automatically when it starts if the files in
the database folder are from a previous version. Please back up your database files
before letting Cantor update them.

Cantor doesn’t bother to update the Club.nx1 and RatingList.nx1 files since
they only contain the same data that is in the club and rating lists you imported. If
Cantor finds these files are from a different version, it will simply delete them and
create new, empty ones that are for the current version.

If you have database files from Cantor version 1 or 2 and you used different
director IDs for different events, then Cantor won’t be able to update the files.
In this case, keep your old version of Cantor to access the old files. If you have
multiple versions of Cantor installed, be sure you don’t enter the same event into
more than one version.

1.2. Moving Files. If you move the database files from one computer to an-
other by writing them to a CD or if you restore them from a backup on a CD,
the files may end up being read-only. When you start Cantor, you will get an error
message to this effect. To fix the problem, right-click the files in Windows Explorer,
select Properties, and uncheck the Read-only check box.

Sometimes, if you move the database files to a different version of Windows,
Cantor will need to do a database pack when it starts. If it does, you may see a
slight delay when Cantor starts. The reason is that Windows is telling the database



3. NOTATION 15

that the way it sorts strings may be in a slightly different order from the other
version of Windows, and the database wants to make sure that everything will
work correctly.

2. Language

Cantor only accepts characters that are in the ISO 8859-1 (Latin 1) character
set (en.wikipedia.org/wiki/ISO_8859-1). In general, Cantor will use your Windows
locale. But, if your Windows locale does not use the Windows 1252 (Latin 1) code
page, Cantor will use the US English locale for sorting strings. This may affect the
order in which records are displayed in grids.

3. Notation

In this manual, I’ll write the names of menu items, buttons, field labels, etc.
in a slanted sans-serif font, e.g., Rating List. I’ll specify sequences of menu items,
buttons, etc. by separating them with a “>” sign. The double colon “::” means that
the sequence of items starts at the main menu. For example, you can exit Cantor
via ::Cantor > Exit. I’ll write keys on the keyboard by putting the name of the key
between angle brackets, e.g., 〈Ctrl+Del〉 or 〈Enter〉. Note that 〈Ctrl+Del〉means hold
down the control key and press the delete key.

en.wikipedia.org/wiki/ISO_8859-1




CHAPTER 2

Overview

This chapter provides a brief overview in the form of a tutorial. Working
through this tutorial is not a substitute for reading the rest of the manual.

Start Cantor. You will see the quick-start window (see Figure 1). Cantor only
displays this window if you haven’t entered any results. Close the window. You
will see Cantor’s main window (Figure 2 on the next page).

Select ::Lists > Import. You will see the window shown in Figure 3 on the
following page. Click the button at the right of the Rating list field and select
the file SampleRatingList.csv in the program folder (e.g., C:\Program Files (x86)
\RatingsCentral\Cantor). Click the button at the right of the Club list field and
select the file SampleClubList.csv in the program folder. Click the Import button.
Cantor will import the lists.

Select ::Events > Select Current. You will see the window in Figure 4 on page 19.
Click the Add Event button. The notebook will switch to the Edit page (see Figure 5
on page 19). Type “Ratings Central Open” in the Name field. Click the button at
the right of the Date field to drop down a calendar. Click the Today button. Set
State to “VA”. Click on the Change button to pop up the club browser (Figure 6
on page 20). Click the Select Club button to select the VTTA club and close the
window. Enter “1600” in the Unrated prior > Mean field, and enter “200” in the
Unrated prior > Standard deviation field (see Chapter 9 on page 59 for instructions
on how to set the Unrated prior fields for your event).

Click the Save button. You will see the Browse page and the event you just
added will be listed in the grid (see Figure 7 on page 20). Click the OK button.
The main window now displays the name and date of the event (see Figure 8 on
page 21).

Select ::Players > Modify . You will see the window in Figure 9 on page 21. We’ll
assume the players have played in a previous event and so are on the rating list.

Figure 1. Quick-start window
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18 2. OVERVIEW

Figure 2. Main window

Figure 3. Import window

If you have players who have not played in a previous event, then you would add
them by clicking the Add Player button.

Since we are assuming the players are on the rating list, click the Rating List
button. You will see the rating-list browser (Figure 10 on page 22). Click the Add
Player button to add David H. James to the event. You will now see the Edit page
of the modify-players notebook (Figure 11 on page 22). Click the Save button.

Click the Rating List button to bring up the rating list again. This time, click
on the line that says “O’Neill, Sean Patrick”, then click the Add Player button. Click
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Figure 4. Select-current-event window

Figure 5. Edit-event page
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Figure 6. Club browser

Figure 7. Event grid

the Save button. The window should look like Figure 12 on page 23. Click the Close
button.

Click the New Result button at the bottom of the main window. You will see the
window in Figure 13 on page 23. Click “O’Neill, Sean Patrick” in the Winner (left)
list box and “James, David H.” in the Loser (right) list box. Enter “7”, “-4”, “10”, and
“2” in the Score boxes. The window will look like Figure 14 on page 24. Click the
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Figure 8. Main window showing event name and date

Figure 9. Modify-players window
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Figure 10. Rating-list browser

Figure 11. Edit-player page

OK button. Click the Cancel button to close the window. The main window will
look like Figure 15 on page 24.

The final step is to submit the event to Ratings Central. Submitting events is
covered in Section 3 on page 41 rather than in this tutorial. But, you don’t want
to submit the test event that you just created. So, click anywhere in the grid, e.g.,
click Sean’s name. The result row in the grid will now be highlighted and the words
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Figure 12. Player grid

Figure 13. New-result window

"Ctrl+Del: Delete Result" in the bottom left will no longer be dimmed (see Figure 16
on page 25). Press 〈Ctrl+Del〉 to delete the result. Then select ::Events > Select
Current and press 〈Ctrl+Del〉 to delete the event. This also deletes the players in
the event. Select ::Cantor > Exit to close Cantor, and then use Windows Explorer to
delete the Club.nx1 and RatingList.nx1 files in the database folder. The location of
the database folder is displayed in the status bar at the bottom of Cantor’s main
window (see Chapter 7 on page 53).

Note that the sample rating list and club list files you used in this overview
are just samples—they do not contain real players or clubs. Their only purpose
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Figure 14. Result being entered

Figure 15. Main window showing result

is to let you work through this overview. Do not use them when running a real
event that you will submit to Ratings Central. See Section 1 on page 33 for how to
download and import real rating and club lists.

Before entering a real event into Cantor, please enter your Internet parameters
(see Section 3 on page 28) and perform the test in Section 3.3 on page 30 to make
sure you can submit events.

Before submitting a real event to Ratings Central, please read Chapter 9 on
page 59 to learn how to set the mean and standard deviation for unrated players.
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Figure 16. About to delete result





CHAPTER 3

Cantor Menu

The Cantor menu contains items that relate to the application as a whole.

1. Exit

The Exit menu item closes Cantor. No information is lost when you do this
because Cantor always writes all information to the database files immediately
after completing any operation.

2. Set Up

The Set Up menu item brings up a window (Figure 1) that lets you set your
director ID and password and the location of the list database folder.

2.1. Director. Enter your director ID in the ID field. To get a director ID, you
must register on the Ratings Central website. Your director ID is not the same as
your player ID (if you have one). Once you’ve submitted an event, Cantor won’t
let you change the director ID. Do not share your director ID with anyone else. If
more than one person will be submitting events for your club, each person should
register as an event director.

Figure 1. Set-up window
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28 3. CANTOR MENU

Enter your director password in the Password field. You select your password
on the Ratings Central website. Since this is a password, Cantor will display as-
terisks in this field rather than the characters you type. The password is case
sensitive.

Select the sport that corresponds to your director ID in the Sport field. If you
want to submit events for more than one sport, you will need a director ID for each
sport; see Appendix D on page 83.

2.2. List Database Folder. The rating-list database file RatingList.nx1 and the
club database file Club.nx1 contain the same information that is in whatever rating
and club lists you’ve imported. Since the rating-list database file can be rather large
and there is no need to back up either of the list database files, you may wish to
keep them in a folder other than the database folder, thus making it simpler to
back up the database files that you do need to back up whenever you use Cantor.
Another reason you might wish to do this is if you have more than one director
ID—see Appendix D on page 83. You can use the same list-database folder for both
Cantor and Zermelo (or two or more instances of either of them), but if you do so,
you can only have one app running at a time.

Enter the folder you wish to use in the List database folder field. Leave the
field blank to use the database folder as the list database folder. You can enter
the name of a folder that doesn’t exist and Cantor will create it. You can click the
button to the right of the field to browse to the folder you want.

If you have already imported a list, changing the list database folder will not
move the list database files. You will either have to move them yourself or import
the lists again. If you wish to move them yourself, do it when Cantor is not running.

3. Set Up Internet

The Set Up Internet menu item brings up a window (Figure 2 on the facing
page) that lets you set your email and Web parameters. Cantor uses these when
submitting events to Ratings Central and when downloading rating and club lists.

Put your email address in the Your address field. Ratings Central will send con-
firmation messages to this address. Enter only your email address; don’t include
angle brackets or a display name.

Cantor can submit events to Ratings Central using either email or the Web.
Select the method you prefer in the Submission method drop-down list. The Web
submission method is easier to set up and will work with more Internet connec-
tions. The email submission method will probably work more quickly.

3.1. Email. Enter the name of your SMTP (outgoing mail) server in the SMTP
server field. This is typically something like smtp.YourISP.com or mail.YourISP.
com. For example, RCN uses smtp.rcn.com. Many ISPs include this information
on their websites in their instructions for setting up your email client. If you use
Eudora as your email client, you can find the SMTP server name in ::Tools > Op-
tions > Sending Mail. If you only use webmail, then you probably won’t find the
SMTP server name in your email settings. If you can’t find the SMTP server name
anywhere, ask your ISP.

http://www.ratingscentral.com
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Figure 2. Set-up-Internet window

Enter your SMTP port in the SMTP port field. The standard ports for SMTP are
25 and 587. If your ISP doesn’t tell you the port that they use for their SMTP server,
try both of them (both, one, or neither may work).

Some ISPs have their SMTP servers set up to use authentication (i.e., to require
a username and password). If your ISP uses SMTP authentication, check the Use
authentication check box. Then enter your account username and password in the
Username and Password fields. If the SMTP server supports TLS, then check the Use
TLS check box (if you check this check box, but the server does not support TLS,
Cantor probably won’t notice the error). TLS encrypts the communication with the
server so your password is not sent in clear text. If you aren’t sure whether your ISP
uses SMTP authentication, try it first without authentication, since most ISPs don’t
use it. Note that just because you have a username and password doesn’t mean
your ISP uses SMTP authentication. You always have a username and password so
that you can access the POP (incoming mail) server.

If your ISP account doesn’t provide an SMTP server or you don’t know how to
configure Cantor to use it, then use the Web submission method.

3.2. Web Proxy Server. Usually, you don’t have to set any Web parameters.
However, some Internet connections use a proxy server to access the Web. It is
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Figure 3. Test-sent window

From: Ratings Central
Subject: Ratings Central: test received
To: David Marcus
Date: Tue, 29 Jul 2003 23:13:56 -0400

Submitted: July 29, 2003, 10:17 pm
Status: Test

We received the test you sent.

Ratings Central
www.ratingscentral.com

Figure 4. Test reply email

unlikely that a home connection uses a proxy server, but it is moderately common
for companies to use proxy servers. Cantor uses the Web proxy server parameters
when downloading rating and club lists and when submitting events to Ratings
Central using the Web submission method.

You can find whether you are using a proxy server by looking at your Inter-
net options in Windows: Control Panel > Internet Options > Connections > LAN
Settings. . . > Proxy server. If the Use a proxy server for your LAN check box is
checked, then you should check Cantor’s Use proxy server check box and copy the
values from the Windows Address and Port fields to Cantor’s Server name and Port
fields. If your proxy server requires a username and password enter them in the
Username and Password fields.

Sometimes a company uses a proxy server, but you can still access the Web
even if you leave the User proxy server check box unchecked.

3.3. Test. Click the Test button to test your Internet setup. When you click this
button, Cantor will send a test submission to Ratings Central. If Cantor succeeds
in sending the test, it will display the window in Figure 3. Ratings Central will
respond with an email like the one in Figure 4. The “Submitted” date and time in
the email will be the date and time that you clicked the Test button.
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Figure 5. Select-printer window

4. Select Printer

The Select Printer menu item brings up a window (Figure 5) that lets you select
which printer Cantor prints to. If you select “Default”, then Cantor will print to
whichever printer you’ve set as the default printer in Windows. Cantor stores the
printer you select in the Cantor.inifile, so Cantor will remember the value even after
you quit Cantor.

5. Visit Website

The Visit Website menu item opens your browser on the Ratings Central home
page (http://www.ratingscentral.com). To get to the “Event Director Support” web-
page, log in using your director ID number and password where it says “Event
Director Login” in the left sidebar below the ads on any page on the website.

6. Display Version

The Display Version menu item brings up a window (Figure 6 on the following
page) that shows version and copyright information. The version number is also
shown in the title bar of Cantor’s main window. You can find the latest version of
Cantor on the Ratings Central website.

You can click on the photo to go to a webpage about Georg Cantor.

http://www.ratingscentral.com
http://www.ratingscentral.com
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Figure 6. Version window



CHAPTER 4

Lists Menu

The Lists menu contains items that let you import rating or club lists and
browse the imported lists.

1. Import

The ::Lists > Import menu item brings up a window (Figure 1) that lets you
import a rating list or club list into Cantor.

You don’t need a rating list to use Cantor, but a rating list makes entering
players much simpler. Similarly, you don’t need a club list, but without one, Cantor
won’t let you enter clubs for players or events.

To add your club to the Ratings Central club list, go to the Ratings Central
website and log in (see Section 5 on page 31).

Ratings Central provides players’ personal information so that you can publi-
cize and run your events. Please respect players’ privacy—do not use the informa-
tion for other purposes or give it to anyone else.

There are two ways to download the rating and club lists: automatic and man-
ual.

1.1. Automatic Download. To have Cantor automatically download the rating
and club lists from the Ratings Central website and import them, set the Source
drop-down list to “Web”. You won’t be able to select “Web” unless you’ve already
entered your director ID and password via ::Cantor > Set Up.

Figure 1. Import-lists window

33
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Figure 2. Download window

If you’ve previously imported lists, then the Existing records radio box will be
active. If you select the Discard all radio button, then all the records that you
previously imported will be discarded. If you select the Keep radio button, the
new records you are about to import will be appended to the ones you previously
imported. (If you previously imported the sample rating or club lists that come
with Cantor, be sure to select Discard all.)

If you select Keep, then the For duplicates, keep. . . radio box will be active.
You have a duplicate record if there are two records for the same player ID or club
ID number. If you select New, then the new record for any duplicate will be kept
and the old one will be discarded. If you select Old, then the old record will be kept
and the new one discarded.

Click the Import button to download and import the lists. Figure 2 shows the
window that Cantor will display while downloading. Once the lists are downloaded,
Cantor will automatically import them.

In addition to importing the lists, Cantor will place text copies of the lists in
the RatingList.csv and ClubList.csv files in the list database folder (see Section 2.2
on page 28). See Section 1.2 for more information on these two files.

If you connect to the Web via a proxy server, you will need to enter your proxy
server information in ::Cantor > Set Up Internet.

1.2. Manual Download. To download a rating list and a club list manually, go
to the Ratings Central website and log in (see Section 5 on page 31). Click the
“Version 2” link that is just below where it says “Download zipped table tennis
rating and club lists”. This will download the two lists in a single zip archive. Save
the file.

You will need any unzip program to extract the two lists from the archive. If
you have Windows XP, Vista, or 7, then you don’t need a separate unzip program
because they have built-in support for unzipping files. There are dozens of unzip
programs available on the Web.

Extract the contents of the zip file. You should now have two files: RatingList.
csv and ClubList.csv. These are CSV files. “CSV” stands for comma-separated val-
ues. A CSV file is just a text file with commas separating the values.

Excel understands CSV files, so you can open them in Excel, if you wish. You
can’t have a list open in Excel while you are trying to import it into Cantor. If
you do this, you’ll get an error message that says something like “Cannot open file
RatingList.csv: The file is open in another application.” Excel uses a nonstandard
CSV format—Cantor can import lists that are in either the standard CSV format or
in Excel’s CSV format.

http://www.ratingscentral.com
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MemberID,Name,Rating,State,Zip,Gender,DateOfBirth,ExpirationDate,LastPlayedDate
8840,"O’Neill, Sean Patrick",2484,VA,22903,M,1/2/1967,12/31/2099,8/31/2003
56475,"James, David H.",1827,VA,23227-1721,M,3/4/1973,9/30/2002,11/25/2001

Figure 3. Sample USATT rating list

Once you’ve downloaded the rating list and the club list, you are ready to
import them. Set the Source drop-down list to “File”. To import the rating-list file,
RatingList.csv, type the filename of the file in the Rating list field. Include the path
to the folder where the file is, e.g., C:\My Documents\RatingList.csv. Alternatively,
click on the button at the right of the field to browse for the file.

To import the club-list file, ClubList.csv, type the filename including path in
the Club list field, or click on the button at the right of the field to browse for the
file.

You can import both a rating list and a club list at the same time. If you do so,
then the selections you make in the radio boxes apply to both lists.

Click the Import button to import the lists.
Note that the rating list and club list are sport specific. So, if you have more

than one director ID and the director IDs are for different sports, be sure you
download and import the lists that are appropriate for your event’s sport.

1.3. USATT Rating List. Cantor can also import a USATT rating list in CSV
format that you can get from USATT. USATT provides a publicly-accessible list
that does not include birth and a list that is only available to tournament directors
that does include birth. Cantor can import either version of the list. Figure 3 shows
the first few lines from such a list. To compare Figure 3 to the file that you receive
from USATT, view the file in Notepad, not Excel. The first/header line must have
the column headers shown (ignoring case) and in the same order (the “DateOfBirth”
column can be omitted). Each succeeding line must have the information for one
player with the fields separated by commas. Any field that contains a comma must
be surrounded by double quotes. Names must be in “Last, First” format. Unrated
players must have a rating of “0” or blank. Dates must be in m/d/yyyy format.
Gender must be either “M”, “F”, or blank. Players with life memberships must have
an expiration date of “12/31/2099”.

Import the USATT rating-list file the same way that you would import the Rat-
ings Central RatingList.csv file, i.e., set the Rating list field to the name and path of
the file and click the Import button.

You can import both a Ratings Central rating list and a USATT rating list. When
you import the second rating list, you will need to select the Keep radio button in
the Existing records radio box. For the For duplicates, keep. . . radio box, it doesn’t
matter whether you select New or Old because Cantor knows to not confuse player
IDs from the two organizations.

If Cantor encounters a problem with any line in the file you are importing, it
will display a window with a message explaining what the problem is and what line
is causing the problem. The window will have two buttons: Continue Importing
and Stop Importing. Click the Continue Importing button to continue importing
subsequent lines in the file. Click the Stop Importing button to stop importing
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Figure 4. Import-lists error window

lines from the file. In both cases, any lines already imported will remain imported
and the problem line will not be imported.

Some players in USATT’s ratings.csv file may have temporary ID numbers.
These are USATT ID numbers that are greater than 999999. Cantor will import
these players, but not their temporary ID numbers. That is, when you browse the
rating list, these players will have blank USATT ID numbers.

1.4. Import Errors. If Cantor encounters a problem parsing a line in a list that
it is importing, it will display a window like Figure 4. Click the Continue Import-
ing button to skip the line and continue importing the list. Click the Continue and
Ignore Errors button to skip the line, continue importing, and silently skip any sub-
sequent lines that have errors. Click the Stop Importing button to stop importing
the list.

2. Browse Rating

The Browse Rating menu item brings up a window that lets you browse the
rating lists that you’ve imported. See Section 1.3 on page 47 for more information.

3. Browse Club

The Browse Club menu item brings up a window that lets you browse the club
list that you’ve imported. See Chapter 8 on page 57 for more information.



CHAPTER 5

Events Menu

The Events menu contains items that let you set the current event, add events,
set event parameters, and submit events to Ratings Central.

Ratings Central identifies an event by its date and director ID. So, Cantor only
allows you to have one event on a given date. If you need to submit two events
on the same date, see Appendix D on page 83. Do not use the same director ID
with Zermelo to submit a tournament on the same date as an event that you are
submitting with Cantor.

1. Multiple-Day Events

While events are identified by their date, you don’t have to have all the matches
be played on a single day. For example, if you run a tournament that lasts two or
three days, it makes sense to consider all the matches as being from a single event.
If you play matches at your club several nights during the week, you could consider
the week’s matches to be a single event. Or, you could treat each day’s matches as
a different event. It is up to you.

Ratings Central will calculate slightly different ratings depending on how you
group the matches into events. Bunching up matches should generally improve
the accuracy of the ratings. In particular, if you have a large number of unrated
players, it is generally better if you can bunch up more matches into a single event.
However, all the matches in a single event should be from a reasonably short span
of time, i.e., a few weeks. If you aren’t sure what to do, please contact us for advice;
see http://www.ratingscentral.com/Problems.php for our email address.

Even if your event lasts more than one day, you can still submit the event
each day. When you resubmit the event on subsequent days, Ratings Central will
recalculate the ratings taking into account all the matches in the event.

If you submit an event or tournament, then you should include all matches
that were played in the event or tournament, i.e., don’t just submit the matches
played by your club members, for example. Your tournament can (if you wish)
have individual events that count for ratings and also individual events that do
not count for ratings, in which case you would only submit the matches in the
individual events that count for ratings.

2. Select Current

The Select Current menu item brings up a tabbed-notebook window (Figure 1
on the next page) that lets you select which event is the current event. The current
event is displayed in Cantor’s main window and is the event that you can add
players and results to.
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Figure 1. Select-current-event window

The Select Current menu item also lets you browse and add events and set the
parameters for each event.

2.1. Browse. The first page of the notebook (the Browse page) contains a grid
listing the events along with various parameters for each event. Just like Cantor’s
other grids, you can resize a column by dragging an edge of the column header,
you can rearrange the order of the columns by dragging a column header with
the mouse, and you can sort the grid on a column by clicking the button to the
right in the column header. You can only sort the grid on columns that have the
button. The column that is being used for sorting will show a downward-pointing
arrowhead in the button.

The grid lets you select which event is the current event. The current event is
indicated by the right-pointing arrowhead in the leftmost column of the grid. If the
grid has the focus (see Section 4 on page 74 for an explanation of “focus”), then
the current event is also highlighted. When you click the OK button to close the
window, Cantor will update the main window so it displays the name, date, and
results of the current event. If you click the Cancel button, then Cantor will not
change which event was current. You can also double-click the row of an event to
select it as the current event and close the window.

The columns of the event grid display information that you can also view on
the Edit notebook page. Each column is described below when we describe the Edit
page.
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Figure 2. Edit-event page

The Add Event button switches to the Edit page to let you add a new event.
The Edit Event button switches to the Edit page for the currently selected event;
you can also click the Edit notebook tab.

Press 〈Ctrl+Del〉 to delete the event that is highlighted. The grid must have the
focus for you to delete an event. Cantor will not let you delete an event if there
are any match results entered for the event or if you have submitted the event and
made any modifications to the event since you’ve submitted it. If you want to delete
such an event, first delete all the results. If you haven’t previously submitted the
event, you will now be able to delete it. If you have previously submitted the event,
then resubmit it. You won’t receive an email confirmation when an event with no
results is processed, so check on the Ratings Central website that the event is no
longer there (to make sure that the resubmission worked). Then, delete the event.
You can tell whether you can delete the highlighted event by whether the words
“Ctrl+Del: Delete Event” just below the grid are dimmed or not.

2.2. Edit. Figure 2 shows the Edit notebook page.
2.2.1. Navigation and Saving. Any changes you make on the Edit notebook

page are not saved to the database files until you save them. One way to save your
changes is to click the Save button. If you click the Browse notebook tab, Cantor
will save your changes just as if you clicked the Save button.

In the bottom left of the window there is a navigator bar with four buttons.
This lets you move to a different event without first going back to the Browse page.
The left navigator button moves to the first event (order of events is determined by
how the grid on the Browse page is sorted), while the right navigator button moves

http://www.ratingscentral.com
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to the last event. The middle-left button moves to the event before the one that
is displayed, while the middle-right button moves to the event after the displayed
one. If you navigate to a different event, Cantor first saves any changes you have
made to the displayed event. If you do not want to save your changes, you should
click the Cancel button instead.

2.2.2. Name. Enter the name of the event in the Name field. You must set the
name for the event.

2.2.3. Date. Enter the date of the event in the Date field. If the event lasts
more than one day, enter the date of the first day. Although the field displays the
date using the month name, you can enter the date using numbers. If you do use
numbers, they must be in the order month-day-year. Generally, Cantor uses your
Windows regional settings to display dates in the format that is appropriate for
your region, but because this field displays the month name, you must enter the
month number first. You can also set the date by clicking the button to the right
of the field to drop down a calendar.

Once you’ve submitted the event, you can’t change the date. If you submit
the event using the wrong date, you will have to delete all the matches, resubmit
the event (to delete it), then enter the matches into a new event on the correct
date. If you feel it is impractical for you to do this, contact us for assistance; see
http://www.ratingscentral.com/Problems.php for our email address.

2.2.4. Match Format. When you enter results, you can select the match format
for each result. Since it would be tedious to have to change the format for every
result, the Match format field lets you set the default format to use when entering
results for matches in the event. In other words, this field lets you set which
match format the New Result window starts out with when you click the New Result
button. See Section 1 on page 54 for more information.

2.2.5. State. Set the State field to the state (for the USA) or province (for
Canada) where the event is located. For countries other than the USA and Canada,
the field will be disabled. Cantor also uses the event state as the default state when
adding new players to the event. When you add a new event, Cantor initializes the
state to the state of the current event.

2.2.6. Country. Set the Country field to the country where the event is located.
Cantor also uses the country as the default country when adding new players to
the event. When you add a new event, Cantor initializes the country to the country
of the current event.

2.2.7. Club. The Club box shows the club that is sponsoring the event. More
than one club can sponsor an event, but Cantor only lets you set one club for the
event. To add another club, you must go to the Ratings Central website and log in
(see Section 5 on page 31). When you add a new event, Cantor initializes the club
to the club of the current event. An event does not have to have a sponsoring club.

Cantor won’t let you type the name of a club in the club field. To set or change
the club, click on the Change button to bring up the club browser. The club browser
is described in Chapter 8 on page 57. The Change button will only be enabled if
you have imported a club list (see Section 1 on page 33). To clear the club, click
the Clear button.

http://www.ratingscentral.com/Problems.php
http://www.ratingscentral.com
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Figure 3. Submit-events window

2.2.8. Unrated Prior. The Mean and Standard deviation fields let you specify
the mean and standard deviation of the playing strength of unrated players in the
event. You must set both of these. See Chapter 9 on page 59 for advice on what to
put in these fields.

2.2.9. Status. The Modified check box indicates whether you’ve made any mod-
ifications to the event, its players, or its results that require that the event be sub-
mitted or resubmitted. This is an informational check box, i.e., you can’t change it.
If the Modified check box is checked, then Cantor will submit this event the next
time you submit events.

The Submitted check box indicates whether the event has ever been submitted.
This is also an informational check box.

The Submit failed check box lets you tell Cantor that the previous submission
of the event didn’t work, i.e., wasn’t received by Ratings Central. If you check this
box, then Cantor will resubmit the event the next time that you submit events. You
will need to re-check any player New personal info check boxes that were checked
in the prior submission. See Section 1.2.12 on page 46 for more information on the
New personal info check box.

For more information on submitting events, see Section 3 and Chapter 10 on
page 63.

3. Submit

The Submit menu item brings up a window (Figure 3) that lets you submit
events to Ratings Central. The menu item will be disabled if you haven’t entered
your director ID and password (in ::Cantor > Set Up) or haven’t set up your Internet
parameters (in ::Cantor > Set Up Internet).

3.1. Submit Events. Click the Submit Events button to submit results to Rat-
ings Central. Clicking this button submits all events to Ratings Central that need
to be submitted. You do not have to, nor can you, specify a single event to submit.
The button will be disabled unless there are events to submit.

If an event has not been submitted before, then it will be submitted if it has any
results. Once an event has been submitted, it will be resubmitted if you’ve made
any changes to the event, its players, or its results that Ratings Central needs to
know about.
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You can tell if an event will be submitted by looking at the grid in ::Events >
Select Current. Cantor will submit the event if the row for the event says “Modified”
or “Submit Failed”. You can also look on the Edit page of the notebook to see if
either the Modified check box or the Submit failed check box is checked.

See Chapter 10 on page 63 for what happens when you submit events.
If you need to correct any of the match results, player data, or other informa-

tion that you submitted, just correct them and then click the Submit Events button
to submit the events again. If you are correcting a player’s personal information,
you will have to check the player’s New personal info check box. Do not check
the New personal info check box if you are only correcting a player’s ID, rating,
or unrated prior. See Section 1.2.12 on page 46 for more information on the New
personal info check box. See Section 1 on page 64 for how to fix a duplicate player.

3.2. Previous Submissions. The grid at the bottom of the window shows each
submission of an event. The grid works like Cantor’s other grids (see Section 9 on
page 77). The “Submitted” column is the date and time that Cantor sent the event
to Ratings Central.



CHAPTER 6

Players Menu

The Players menu contains items that let you add players to, modify players
in, and print lists of the players in the current event. The current event is the one
that is displayed in the main window and which you selected via ::Events > Select
Current.

1. Modify

The Modify menu item brings up a tabbed-notebook window (Figure 1) that lets
you add and modify players in the current event and access the rating list. This
menu item will be disabled until you have selected a current event.

1.1. Browse. The first page of the notebook (the Browse page) contains a grid
listing the players along with various information about each player. The grid
works like Cantor’s other grids (see Section 9 on page 77). The columns of the

Figure 1. Modify-players window
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Figure 2. Edit-player page

player grid display information that you can also view on the Edit notebook page.
Each column is described below when we describe the Edit page.

The Find field lets you search for a specific player. This is an incremental-
search field, so you can type just the first part of what you are searching for and
the grid will move to the first matching player. The search happens after every
keystroke. The value you type must be the sort of thing that is in the column that
the grid is sorted on, e.g., if you want to search for a player by name, you must sort
the grid by name by clicking on the button in the header of the “Name” column.

The Add Player button switches to the Edit page to let you add a new player
to the event. The Edit button switches to the Edit page for the currently selected
player; you can also click the Edit notebook tab or double-click the player’s row.
The Close button closes the window.

Press 〈Ctrl+Del〉 to delete the player that is highlighted. The grid must have
the focus for you to delete a player. Cantor will not let you delete a player who
has any results. (To delete the player, first delete the player’s results.) You can
tell whether you can delete the highlighted player by whether the words “Ctrl+Del:
Delete Player” just below the grid are dimmed or not.

The Rating List button brings up the rating-list browser. See Section 1.3 on
page 47 for more information on the rating-list browser.

1.2. Edit. Figure 2 shows the Edit notebook page. This notebook page handles
navigation and saving just like the ::Events > Select Current > Edit notebook page
(see Section 2.2.1 on page 39).
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1.2.1. Name. Enter the player’s name in the Name field with the last (family)
name first, then a comma, then the first and middle names. If the player’s name
has a suffix, e.g., “Jr.”, add that after a comma at the end. Since Cantor identifies
players by their name, you cannot have two players in an event that have exactly
the same name.

The button to the right of the Name field brings up the rating-list browser
positioned on the player in the rating list whose name is closest to the name you
have in the Name field. The button will be disabled unless you’ve imported a rating
list. The shortcut key for the button is 〈Ctrl+N〉. This shortcut key also works from
the Browse page of the notebook. See Section 1.3 on page 47 for more information
on the rating-list browser.

1.2.2. IDs. Enter the player’s Ratings Central ID number in the Ratings Central
field. If the player does not have a Ratings Central ID (because this is the first time
that the player has played), then leave the field blank.

The button to the right of the Ratings Central field brings up the rating-list
browser positioned on the player whose Ratings Central ID is closest to the value
in the Ratings Central field. The button will be disabled unless you’ve imported a
Ratings Central rating list. The shortcut key for the button is 〈Ctrl+R〉.

Enter the player’s USATT ID number in the USATT field. Ratings Central will
save the USATT ID in its database to help identify the player, but does not use the
USATT ID for any other purpose. If the player does not have a USATT ID, then leave
the field blank.

The button to the right of the USATT field brings up the rating-list browser
positioned on the player whose USATT ID is closest to the value in the USATT field.
The button will be disabled unless you’ve imported a rating list. The shortcut key
for the button is 〈Ctrl+U〉.

Enter the player’s TT Australia ID number in the TT Australia field. Ratings
Central will save the TT Australia ID in its database to help identify the player, but
does not use the TT Australia ID for any other purpose. If the player does not have
a TT Australia ID, then leave the field blank.

The button to the right of the TT Australia field brings up the rating-list
browser positioned on the player whose TT Australia ID is closest to the value
in the TT Australia field. The button will be disabled unless you’ve imported a
Ratings Central rating list. The shortcut key for the button is 〈Ctrl+T〉.

See Section 1.3 on page 47 for more information on the rating-list browser.
The shortcut keys for the rating-list-browser buttons also work from the Browse
page of the notebook.

1.2.3. Address. Enter the player’s address in the Address 1 and Address 2
fields. If you only need one line for the player’s address, leave the Address 2
field blank.

1.2.4. City. Enter the player’s city in the City field.
1.2.5. State. Set the State field to the state (for the USA) or province (for

Canada) that the player is from. For countries other than the USA and Canada,
the field will be disabled. When you add a new player, Cantor initializes the state
to the state of the event, since most new players are from the state that the event
is in.
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1.2.6. Province. If the player is from a country other than the USA or Canada
and their mailing address includes a province, enter it in the Province field. The
field will be disabled if the player is from the USA or Canada. Please, use the State
field for Canadian provinces.

1.2.7. Postal Code. Enter the player’s postal code in the Postal code field.
1.2.8. Country. Set the Country field to the country that the player is from.

When you add a new player, Cantor initializes the country to the country of the
event, since most new players are from the country that the event is in.

1.2.9. Email. Enter the player’s email address in the Email field. Enter only the
email address; don’t include angle brackets or a display name.

When you submit an event, Ratings Central will send an email to each player
who played in the event to let them know that the event has been posted. The
email will contain a link to the results on the Ratings Central website and a link so
that the player can opt out of receiving future emails. Of course, the player will
only receive the email if Ratings Central has the player’s email address. At most
one email will be sent to a player for a given event. So, if you resubmit an event
(to make corrections), players who were in the first submission will not receive a
second email.

1.2.10. Sex. Set the Sex field to the player’s sex.
1.2.11. Birth. Enter the player’s birth date in the Birth field. Use the year-

month-day order that matches your Windows regional settings.
1.2.12. New Personal Info. Check the New personal info check box if the per-

sonal information that Ratings Central has for the player is incorrect or incomplete
and you are updating it.

The New personal info check box only applies to the personal information
fields, i.e., the Name, IDs > USATT , IDs > TT Australia, Address 1, Address 2, City ,
State, Province, Postal code, Country , Email, Sex, Birth, and Club fields. If you
check the New personal info check box, the values in all these fields will be sent to
Ratings Central and will replace the corresponding information for the player that
Ratings Central has. Note that this includes any fields that you clear. For example,
if you clear a player’s Email field and check the New personal info check box, then
after you’ve submitted the event, Ratings Central will not have an email for the
player. Also note that if you check the New personal info check box, you should
make sure that all of the personal information fields for the player have the correct
information since all of them will be sent to Ratings Central.

Do not check the New personal info check box if you only make changes to
the Rating, Standard deviation, or Unrated prior fields, since the check box has
nothing to do with these fields.

Generally, you should not check the New personal info check box if you change
the IDs > Ratings Central field. (The most common reason you would change the
IDs > Ratings Central field is if a player has two Ratings Central IDs, an original
one and a duplicate, and you are changing the value in the field to the player’s
original ID.) The Ratings Central ID is not personal information about the player,
but rather identifies who the player is. If you change the IDs > Ratings Central field
and also check the New personal info check box, then this means that you want

http://www.ratingscentral.com
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Ratings Central to update the personal info for the player who corresponds to the
new ID. This is unlikely to be what you want.

See Chapter 10 on page 63 for more information.
The New personal info check box will be disabled if the player’s IDs > Ratings

Central field is blank and the event has not been submitted (since there is no old
info in this case to update). When you submit the event, Cantor will clear the New
personal info check box (since the new info has now been sent to Ratings Central).

Note that Cantor only submits a player to Ratings Central if the player has
played at least one match. So, checking the New personal info check box will have
no effect if the player doesn’t play any matches in the event.

1.2.13. Rating. Enter the player’s rating in the Rating field. If the player is un-
rated, leave the field blank or enter an estimated rating. This field is not submitted
to Ratings Central when you submit the event. It is only for your information. It
is displayed in the player grid (on the Browse page of the notebook) and the result
grid (in the main window) and printed on the player and result lists (when you do
::Players > Print or click the Print Results button in the main window).

Note that the Ratings Central and USATT rating scales are different. See Chap-
ter 9 on page 59 for advice on converting between the two scales.

1.2.14. Standard Deviation. Enter the player’s standard deviation in the Stan-
dard deviation field. If the player is unrated, leave the field blank or enter an
estimated standard deviation. This field is not submitted to Ratings Central when
you submit the event. It is only for your information. It is displayed in the player
and result grids and printed on the player and result lists.

1.2.15. Unrated Prior. The Mean and Standard deviation fields in the Unrated
prior box let you specify the mean and standard deviation of the playing strength
of the player, if this is the player’s first event. You can leave these fields blank, but
if you set one, you must set both. See Chapter 9 on page 59 for advice on what to
put in these fields.

1.2.16. Club. The Club box shows the club that the player is from. A player
can be from more than one club, but Cantor only lets you set one club for a player.
The club you set for the player in Cantor will be the player’s primary club. To
add a secondary club for the player, you must go to the Ratings Central website
and log in (see Section 5 on page 31). A player doesn’t have to belong to a club.
If you change an existing player’s primary club (and check the New personal info
check box), the player will still be a secondary member of the old primary club. To
remove the player completely from the club, you must go to the Ratings Central
website and log in.

You set or change the player’s club just as you do for the event club on the
::Events > Select Current > Edit notebook page (see Section 2.2.7 on page 40). If the
player’s club is not set, then when you click the Change button, the club browser
will come up with the event club selected. Since most new players are from the
club that is sponsoring the event, this makes it easy to set these players’ clubs.

1.3. Rating-List Browser. The rating-list browser (Figure 3 on the next page)
lets you view the rating list. You can bring up the rating-list browser from either
page of the player notebook or from the ::Lists > Rating menu item. From the
Browse page of the player notebook you can click the Rating List button. From

http://www.ratingscentral.com
http://www.ratingscentral.com
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Figure 3. Rating-list browser

the Edit page, you can click any of the buttons that show a hand pointing to a list
of records. From either page, you can use the 〈Ctrl+N〉, 〈Ctrl+R〉, 〈Ctrl+U〉, and
〈Ctrl+T〉 shortcut keys. These bring up the rating-list browser on the player whose
name, Ratings Central ID, USATT ID, or TT Australia ID (respectively) is closest to
that of the player that you are editing or that you have selected in the grid on the
Edit page. A button and shortcut will be inactive unless you’ve imported a suitable
rating list via ::Lists > Import.

The rating-list grid works like Cantor’s other grids (see Section 9 on page 77).
The meaning of most of the columns should be obvious. The “Last Played” column
contains the date of the last event that the player played. The “Source” column
indicates whether the record came from Ratings Central (“R.C.”) or USATT. The
“Expiration” column contains the player’s USATT membership expiration date. If
the player has a life membership, the “Expiration” column will say, “Never”.

The Find field lets you search for a specific player. It works like Cantor’s other
incremental-search fields (see Section 9.1 on page 77).

Click the Add Player button to close the rating-list browser and add the se-
lected player to the current event. If you were editing a player (i.e., you were on
the Edit page of the player notebook), Cantor will save any changes you made to
the player. Then Cantor will add a new player to the current event and copy the
information for the player you selected in the rating-list browser from the rating
list to the new-player’s fields, all ready for you to save the player.

Click the Overwrite Player button to close the rating-list browser and overwrite
the player you were editing or had selected in the player grid with the player you
selected in the rating-list browser.

Click the New Player button to close the rating-list browser and add a new,
blank player to the current event. If you were editing a player, Cantor will save
any changes you made to the player. If the rating-list grid is sorted on the “Name”
column, Cantor will set the new-player’s name to the contents of the Find field. If
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Figure 4. Copy-players-from-event window

the string in the Find field is all lower case, Cantor will capitalize the initial letters
of words when setting the new-player’s name. This makes it easy to add a player
when you discover that the player you are looking for is not in the rating list.

Click the Close button to close the rating-list browser without changing the
players in the event.

If you open the rating-list browser from the Rating List button on the Browse
page, the Overwrite Player button will be disabled. If you open the rating-list
browser from the ::Lists > Rating menu item, the Add Player, Overwrite Player, and
New Player buttons will be disabled.

If the Overwrite Player button is enabled, then you can double-click a player in
the grid to overwrite the player you are editing with the player you double-clicked.
If the Overwrite Player button is disabled, but the Add Player button is enabled,
then you can double-click a player in the grid to add the player to the current event.

If the list database folder is set (see Section 2.2 on page 28), the title bar of the
window shows the folder’s location.

2. Copy from Event

The Copy from Event menu item brings up a window (Figure 4) that lets you
copy players from another event into the current event. This is a convenient way
to add players to the current event if another event has many players in common
with the current event. The menu item will be disabled if you don’t have at least
two events.

Select the other event in the grid. Then click the OK button. Cantor will copy
the players from the selected event to the current event. Cantor will only copy
players that have Ratings Central ID numbers. Cantor will not copy a player if the
player’s name or player’s Ratings Central, USATT, or TT Australia ID number is the
same as that of a player who is already in the current event.

You can also double click the event in the grid. This will select the event and
immediately copy the players.

If you check the Update info from rating list check box, then Cantor will replace
each copied player’s information (i.e., name, address, rating, etc.) with the player’s
information from the rating list.
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Figure 5. Import-players window

Note that if you create an event and add players to it, but never add any results
to it, then Cantor will never submit it. So, for example, you could create a dummy
event containing the members of your club and copy the players from this dummy
event to each new event that your club runs.

3. Import

The ::Players > Import menu item brings up a window (Figure 5) that lets you
import players from the rating list into the current event. The menu item will be
disabled until you have selected a current event and have imported a rating list.

You specify the players to import by providing a text file containing IDs. The
file must have each ID on its own line. Blank lines are ignored, as are leading and
trailing spaces and tabs.

You can construct this file in many ways. Possibilities include the following:
You could keep or create a list of players in Excel or Microsoft Access, then write
the IDs to a file (e.g., Save As Text) or copy them into a text editor such as Notepad.
You could open the Ratings Central rating list in Excel, sort and filter it to make
it more manageable, mark the players who are coming to your event, sort them to
the top or filter to select just them, then copy the IDs to Notepad. You could copy
a list of players from a page on the Ratings Central website, then edit the list to
contain the IDs that you want.

Set the Organization drop-down list to the organization that assigned the IDs.
If you have imported a Ratings Central rating list, then you can use IDs from Rat-
ings Central, USATT, or TT Australia. Note that it is up to event directors to enter
the USATT and TT Australia IDs into the Ratings Central database, so these values
may be missing for some players on the Ratings Central rating list. If the only
rating list that you have imported is from USATT, then you can only use IDs from
USATT, since these are the only IDs on the USATT rating list.

Type the filename of the file of IDs in the ID list field. Include the path to the
folder where the file is. Alternatively, click on the button at the right of the field to
browse for the file.

Click the Import button to import the players. If any players cannot be im-
ported, Cantor will display a window listing the IDs that could not be imported
and the reason. The possible reasons are

• Bad value for ID. The ID value is not an integer or not in the correct range.

http://www.ratingscentral.com
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Figure 6. Print-lists window

Figure 7. Player list sorted by name

• Already a player in event with ID.
• ID not found on rating list.
• More than one player on rating list with ID. So, it isn’t clear which player

should be imported.
• ID from a different organization conflicts with a player in event. The

player was found on the rating list, but the record for the player in the
rating list includes an ID from a different organization that is the same as
a player already in the current event.

•
• Already a player in event with same name. Since Cantor identifies players

by their name, you cannot have two players in an event that have exactly
the same name.

If you have imported rating lists from both USATT and Ratings Central and
are importing players by specifying USATT IDs, then Cantor will first look for the
player on the Ratings Central list, and import that record, if there is one. If there
isn’t one, then it will look for the player on the USATT list.

If the state or country on the rating list are not valid, Cantor will use the state
and country values for the current event.

If the gender value on a USATT rating list record is missing, Cantor will use
male.

4. Print

The Print menu item brings up a window (Figure 6) that lets you print lists of
the players in the current event.

If you check the Name check box, Cantor will print a player list sorted alphabet-
ically (see Figure 7). If you check the Rating check box, Cantor will print a player
list sorted in order of rating (see Figure 8 on the next page). The latter list also
shows the seeding of each player in the event.
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Figure 8. Player list sorted by rating



CHAPTER 7

Main Window

Figure 1 shows Cantor’s main window. The main menu is at the top. Below
that is the name and date of the current event. Below that is a grid showing all the
match results for the current event. The grid works like Cantor’s other grids (see
Section 9 on page 77).

The event date is displayed using long date format specified in your Windows
regional settings. You can change these settings in Control Panel > Regional and
Language Options.

Press 〈Ctrl+Del〉 to delete the result that is highlighted. The grid must have the
focus for you to delete a result.

The “#” column shows the order in which you entered the results. So, result
#1 is the first result that you entered for the event, result #2 is the second, etc.
Deleting a result does not change the numbers of the other results.

The status bar at the bottom of the window shows the location of the database
folder.

Figure 1. Main window
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Figure 2. Result window

1. New Result

The New Result button brings up a window (Figure 2) that lets you enter results
for the current event. The button will be disabled until you’ve added at least two
players to the current event.

Select the winner in the Winner (left) list box and select the loser in the Loser
(right) list box. In addition to using the mouse or cursor keys, you can also type
the player’s name. See Section 11 on page 78 for more information.

Set the Match format field to the format for the match. Choices are “2 of 3”,
“3 of 5”, “4 of 7”, “5 of 9”, and “Games” (the “Games” choice is explained below).
Cantor initializes the Match format field to the match format you selected for the
event.

Enter the score for each game in the Score fields. Only enter the number of
points that the loser of each game got. If the winner of the match lost a particular
game, prefix that game’s score with a minus sign. For example, if the scores for a
match are 11–5, 10–12, 11–8, 11–3, enter “5”, “-10”, “8”, and “3”.

If you don’t know the score for a result, but you know the number of games
won and lost, you can select “Games” in the Match format field. If you don’t know
the score at all, you can check the No score check box.

Unlike most windows, the result window does not have a default button. There-
fore the 〈Enter〉 key will behave more like the 〈Tab〉 key.

The result window is special in that when you press the 〈Enter〉 key, Cantor
tries to be smart about which field or button to move to next. If you press 〈Enter〉
and you’ve entered a complete result, Cantor moves you to the OK button.

Click the OK button to store the result. Cantor will clear the window, but
leave it up so you can enter another result. If you do not have any more results,
you can press 〈Enter〉 to select the Cancel button (which is, for the moment, the
default button) to close the window. Cantor will display the new results in the main
window’s grid.

2. Modify Result

To modify a result that you’ve already entered, either double-click the result
or select the result in the grid and click the Modify Result button. This brings up
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Figure 3. Result list

the result window (the same window you use for entering new results). Correct the
information for the result and click the OK button.

3. Print Results

Click the Print Results button to print a list of all the results in the current
event (see Figure 3). The list shows the same information that is displayed in the
result grid. The results will be in the same order as they are in the grid. So, to
change the printed order, change the order in the grid (by clicking the button in
the header of a grid column).





CHAPTER 8

Club Browser

The club browser (Figure 1) lets you view the club list and select the club of
a player or event. You can bring up the club browser from the Club > Change
button of the Edit pages of the player (::Players > Modify) and event (::Events >
Select Current) notebooks or from the ::Lists > Club menu item.

The grid works like Cantor’s other grids (see Section 9 on page 77). The Find
field lets you search for a specific club. It works like Cantor’s other incremental-
search fields (see Section 9.1 on page 77).

If you’ve brought up the club browser by clicking the player or event Club >
Change button, then the Select Club button will be enabled. Click this button to
make the club that is selected in the grid the club of the player or event.

Figure 1. Club browser
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CHAPTER 9

Unrated Players

When Ratings Central processes an event, it first assigns a prior mean and stan-
dard deviation to each unrated player in the event. (The adjective “prior” means
that it is the player’s mean and standard deviation prior to the start of the event.)
If you entered a prior mean and standard deviation for the player (in ::Players >
Modify > Edit > Unrated prior), then it uses those values. If you didn’t enter a
prior mean and standard deviation for the player, then it uses the prior mean and
standard deviation that you set for the event (in ::Events > Select Current > Edit >
Unrated prior). Note that it never uses the player’s rating (in ::Players > Modify >
Edit > Rating) for the prior.

The following sections give detailed advice on how to set the individual player
prior means and standard deviations and the event prior mean and standard de-
viation. If you have any questions or aren’t sure what to do, please contact us
for assistance; see http://www.ratingscentral.com/Problems.php for our email ad-
dress.

Please get unrated players at your event as many matches with rated players
of a similar playing level as you can. This will make the resulting ratings for these
players more accurate.

Note that the Ratings Central rating scale (i.e., what playing strength a number
corresponds to) is similar to, but not identical to, the USATT rating scale. To
convert from the USATT rating scale to the Ratings Central scale, subtract 200
points; note that this conversion is only approximate and the number of points
to subtract at lower ratings may be less. The Ratings Central rating scale is not
the same as the ITTF rating scale or the Canadian Table Tennis Association rating
scale.

1. Player Priors

The following advice for setting player priors assumes that you are very fa-
miliar with the rating scale, i.e., you know and play with many players who have
established ratings. If this is not true, then you should probably rely on the event
prior and rarely set individual player priors. If you aren’t sure what to do, please
contact us for assistance.

It is usually a good idea to set the prior mean and standard deviation for as
many unrated players as you can. However, you should only set the prior mean
and standard deviation for an unrated player if you have additional information
about that player. The “additional information” can be any information other than
the player’s match wins and losses in the event (Ratings Central sees those). For
example, you might know the player from before the event or you might watch the
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player play their matches or you might look at how many points the player scored
in their matches.

If a player is different from the general population of unrated players at the
event, e.g., much better or much worse (perhaps because they are very young), then
it would be an especially good idea to set the player’s prior mean and standard
deviation.

If many or most of the players in your event are unrated, then it is especially
helpful to the rating system if you can set the prior mean and standard deviation
for as many of the unrated players as you can.

The prior standard deviation for a player measures how sure you are that you
know that player’s playing strength. You should be willing to bet at 1:2 odds that
the player’s playing strength is within one standard deviation of the mean, and you
should be willing to bet at 2:1 odds that the player’s playing strength is more than
one standard deviation from the mean. (Odds of 1:2 mean that you win $1 if you
win the bet, but you lose $2 if you lose the bet. Odds of 2:1 mean that you win $2
if you win, but you lose $1 if you lose.)

For example, suppose you assign a prior mean of 1200 and a prior standard
deviation of 100 to a player. Then you should be willing to bet at 1:2 odds that
the player is really between 1100 and 1300, and you should be willing to bet at 2:1
odds that the player is really less than 1100 or more than 1300. Equivalently, you
should believe that there is a 2/3 chance that the player is really between 1100 and
1300 and a 1/3 chance that the player is really less than 1100 or more than 1300.

Here are some very rough guidelines: If you know an unrated player extremely
well (e.g., they’ve been playing at your club every week for a couple of years), then
you might use a prior standard deviation of 75. If you only know a player moder-
ately well (e.g., they’ve come to your club a few times and played several matches
with players of a similar level), then you might use a prior standard deviation of
125. If you know very little about a player (e.g., you had the player hit with a rated
player of a similar level for five minutes), then you might use a prior standard
deviation of 200.

If a player has a USATT rating, then that is a source of information. However,
USATT ratings vary widely in their accuracy, so it is best to check that a player’s
USATT rating seems reasonable using your own knowledge of the player. USATT
ratings have been drifting upward over time, and there are also significant regional
differences. USATT ratings are currently probably 200 points higher on average
than Ratings Central ratings. If all you know about a player is their USATT rating,
then we suggest the following: For the prior mean, use their USATT rating minus
200. For players rated at least 1000, use a prior standard deviation of 150. For
players rated less than 1000, use a prior standard deviation of 250.

2. Event Prior

You must always set the event prior mean and standard deviation.
While the prior mean and standard deviation for a player measure what you

know of the player’s playing strength, it is best to interpret the event prior mean
and standard deviation as describing the range of unrated players at your event.
For example, if you think the unrated players range from 800 to 1400, then you
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would use the average of these two values (i.e., 1100) as the mean and the differ-
ence of these two values divided by four (i.e., 150) as the standard deviation.

More precisely, about 2/3 of the unrated players should be within one standard
deviation of the mean (and about 1/3 should be more than one standard deviation
from the mean), 95% should be within two standard deviations, and 99.7% should
be within three standard deviations. So, for the example in the previous paragraph
of a mean of 1100 and a standard deviation of 150, you should think that

• 2/3 of the players are between 950 and 1250,
• 95% of the players are between 800 and 1400,
• 99.7% of the players are between 650 and 1550.

Note that when estimating the event prior standard deviation from the range
of players that you expect at your event, you should interpret the range as being
plus or minus two standard deviations, not three.

If you set the prior mean and standard deviation for any individual unrated
players, then the event prior mean and standard deviation should only describe the
population of unrated players for whom you haven’t set individual prior means and
standard deviations. If you set the prior mean and standard deviation individually
for every unrated player at your event, then Ratings Central won’t actually use the
event prior mean and standard deviation, but you still have to set them.

It is possible that a player that you thought was rated may become unrated
because of a correction to some other event. If this happens, the event prior mean
and standard deviation would be used for the player, even though you thought
it wouldn’t be. But, this eventuality is extremely unlikely, so not worth worrying
about.





CHAPTER 10

Submitting Events

This chapter describes what happens when you submit events.
When Cantor submits an event, it sends the following information to Ratings

Central:

• Your director ID and password from ::Cantor > Set Up.
• All information on the ::Events > Select Current > Edit notebook page

except for Match format and Status
• For each player in the event, all information on the ::Players > Modify >

Edit notebook page except for Rating and Standard deviation (the Unrated
prior > Mean and Unrated prior > Standard deviation are sent)

• All results for the event, including the scores

The way that Ratings Central handles player information is a bit complicated.
To make the explanation clearer, define the player’s RC-ID-and-rating information
to be the information in the IDs > Ratings Central, Unrated prior > Mean, and
Unrated prior > Standard deviation player fields. Define the player’s personal in-
formation to be the information in all the other fields that are sent to Ratings
Central, i.e., the information in the Name, IDs > USATT , IDs > TT Australia, Address
1, Address 2, City , State, Province, Postal code, Country , Email, Sex, Birth, and Club
fields.

While Cantor sends both the RC-ID-and-rating information and the personal in-
formation for each player in the event to Ratings Central, normally Ratings Central
only copies the personal information for a player to its database if it is the first
time that it has received information for that player. The reason for this is that
suppose that you download a rating list, enter a player from the rating list in an
event, don’t make any changes to the player’s personal information that was on
the rating list, and submit the event. Also, suppose that in between the time that
you download the rating list and the time that you submit the event, some other
director makes a change to the player’s personal information. If Ratings Central
always copied the personal information to the Ratings Central database, then the
old values that you submit would overwrite the changes that the other director
made. Similarly, if you were to make a correction to an old event and resubmit it,
all the old player personal information would overwrite the current information.

The exception to this rule of not copying personal information for players al-
ready in the Ratings Central database is if you check the New personal info check
box for the player (the check box is on the ::Players > Modify > Edit notebook page).
If you check this check box, it tells Ratings Central that you have updated the
player’s personal information and that Ratings Central should replace the player’s
personal information in its database with the information that you are submitting.
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See Section 1.2.12 on page 46 for specific instructions on when you should check
the New personal info check box. You can also update a player’s personal informa-
tion by logging in to the Ratings Central website.

Note that the only changes to the ::Players > Modify > Edit notebook page for
a player in an already submitted event that will cause Cantor to consider the event
to be modified (and so resubmit the event) are changes to the player’s RC-ID-and-
rating information or checking the New personal info check box.

When Ratings Central processes an event, it assigns a Ratings Central ID num-
ber to any player in the event who doesn’t have one. You use this ID number to
identify the player in subsequent events, typically by downloading and importing
an updated rating list or by entering the ID number in the IDs > Ratings Central
field in the ::Players > Modify > Edit notebook page.

Cantor and Ratings Central keep track of which player without a Ratings Cen-
tral ID is assigned which Ratings Central ID, so resubmitting an event will work
correctly, even if it contains new players that don’t have Ratings Central IDs. You
only need to use the Ratings Central ID for the player when they play in a subse-
quent event.

When Ratings Central finishes processing the ratings for an event, it will send
you an email like the one in Figure 1 on the next page. (If there are no results in the
event, then it won’t send you an email.) If there is a problem with an event that you
submit, Ratings Central will send you an email like the one in Figure 2 on page 66.

Ratings Central will send an email to each player who played in the event to
let them know that the event has been posted. The email will contain a link to the
results on the Ratings Central website and a link so that the player can opt out of
receiving future emails. Of course, the player will only receive the email if Ratings
Central has the player’s email address. At most one email will be sent to a player
for a given event. So, if you resubmit an event (to make corrections), players who
were in the first submission will not receive a second email.

When Ratings Central receives an event (or a resubmitted event), it processes
the ratings for the event and also processes all subsequent events that any of the
players in the event (or in a subsequent event that is being processed) played in.
Please be careful when viewing old events or results that you don’t click the Save
button even though you haven’t really changed anything.

1. Duplicate Players

If you neglect to enter a player’s Ratings Central ID number for a player who
has one (typically because, although the player had played before, you didn’t notice
them listed on the rating list), then when you submit the event, the player will end
up in the Ratings Central database twice, i.e., there will be two Ratings Central ID
numbers that are really the same player.

The way to fix this is to enter the player’s first Ratings Central ID number
(the ID number that you neglected to enter, not the new one) in the IDs > Ratings
Central field and resubmit the event. After you do this, the second ID number will
be for a player who has not played at all. The system automatically deletes players
who haven’t played.

http://www.ratingscentral.com
http://www.ratingscentral.com
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From: Ratings Central
Subject: Event processed by Ratings Central
To: David Marcus
Date: Wed, 30 Jul 2003 21:38:26 -0400

Event: Ratings Central Open
Event date: July 20, 2003
Submitted: July 30, 2003, 9:38 pm
Status: Processed

Thank you for submitting this event to Ratings Central. We have
finished processing it.

Summary report:

http://www.ratingscentral.com/EventSummary.php?EventID=1138

Detailed report:

http://www.ratingscentral.com/EventDetail.php?EventID=1138

Here is the information that we have for you:

Name (Last, First): Marcus, David
Email: abc@xyz
Director ID: 5044
Title:
Clubs: Boston Table Tennis Center
Address: 25 Beacon St. Apt. 16
City: Somerville
State: Massachusetts
Postal code: 02143-4336
Country: USA
Phone: 617-492-4317
Sport: Table Tennis

If any of this information is incorrect or missing, please log into the
Ratings Central website to correct it.

Ratings Central
www.ratingscentral.com

Official Ratings/Rankings of the Austrian Table Tennis Association, the Lower
Austrian Table Tennis Association, the Salzburg Table Tennis Association, the
Carinthian Table Tennis Association, the Burgenland Table Tennis Association,
the Tyrolean Table Tennis Association, the Vienna Table Tennis Association,
the Styrian Table Tennis Association, Table Tennis Queensland, the Tasmanian
Table Tennis Association, and the Hardbat English Association Of Table
Tennis.

Figure 1. Event-processed email
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From: Ratings Central
Subject: Incorrect Ratings Central password
To: David Marcus
Date: Wed, 30 Jul 2003 21:13:44 -0400

Event: Ratings Central Open
Event date: July 30, 2003
Submitted: July 30, 2003, 7:27 pm
Status: Problem

The director’s password is not correct or the director is not authorized.

Ratings Central
www.ratingscentral.com

Official Ratings/Rankings of the Austrian Table Tennis Association, the Lower
Austrian Table Tennis Association, the Salzburg Table Tennis Association, the
Carinthian Table Tennis Association, the Burgenland Table Tennis Association,
the Tyrolean Table Tennis Association, the Vienna Table Tennis Association,
the Styrian Table Tennis Association, Table Tennis Queensland, the Tasmanian
Table Tennis Association, and the Hardbat English Association Of Table Tennis.

Figure 2. Problem email

Actually, you can keep either of the two player IDs by changing the events for
the other ID and resubmitting. So, you can keep the second ID, if that is easier,
which it may be if different or multiple directors submitted events for the players.

If you need another event director to remove a duplicate, please contact them
directly. If that doesn’t work, please contact us; see http://www.ratingscentral.
com/Problems.php for our email address.

http://www.ratingscentral.com/Problems.php
http://www.ratingscentral.com/Problems.php


CHAPTER 11

Mistakes and Errors

This chapter discusses Cantor’s handling of mistakes or errors in what you
type or click. To correct information that Cantor submitted to Ratings Central, see
Section 3 on page 41.

Cantor checks all values you enter or selections you make to ensure that they
are valid and consistent with all other values. On the other hand, Cantor almost
never asks you to confirm your selections, i.e., it will do what you tell it without
asking you if you really mean it. (Such confirmation dialogs rapidly become tedious
and are often ignored anyway.) If you do make a mistake, Cantor provides ways to
correct it.

If you enter a value that is not valid, Cantor displays an error-message window
(Figure 1). In this window, you cannot select the Close button by pressing 〈Enter〉
or 〈Space〉. This is so you won’t accidentally close the window without noticing it
was there. To close the window, you can click the Close button or press the 〈Esc〉
key. You can also use the standard Windows ways of closing windows, i.e., click
the “×” in the title bar or press 〈Alt+F4〉.

You can copy the message to the clipboard via 〈Ctrl+C〉. You can select all
of the message text via 〈Ctrl+A〉. You can select part or all of the message with
the mouse. Once you click in the message with the mouse, you can use the usual
keyboard keys to change the selection, e.g., 〈Shift+Right〉. If part or all of the
message is selected, 〈Ctrl+C〉 copies the selected text to the clipboard. If nothing
is selected, then 〈Ctrl+C〉 copies the entire message to the clipboard.

Figure 1. Error-message window
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APPENDIX A

Who Was Cantor?

Georg Cantor (1845–1918) was a famous mathematician who founded set the-
ory and introduced the concept of infinite numbers with his discovery of cardi-
nal numbers. He also advanced the study of trigonometric series. Ernst Zermelo
(1871–1953) was also a famous mathematician who developed an axiom system to
lend structure to Cantor’s set theory.

Cantor (the software system) can handle results from any sort of table-tennis
event, structured or not, while Zermelo (the other software system that you can
use with Ratings Central) handles tournaments that are more structured.
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APPENDIX B

Screen Resolution and Font Size

Windows lets you set the screen resolution via Control Panel > Display > Set-
tings > Screen resolution (this is for Windows XP—in other versions of Windows,
the setting may be in a different place). Cantor will work at any screen resolution,
but the higher the resolution, the smaller Cantor’s text will be.

Windows also lets you set the font size (e.g., large or small fonts) via Control
Panel > Display > Settings > Screen resolution > Advanced > General > DPI setting
(again this is the Windows XP location). However, Cantor will ignore this setting.
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APPENDIX C

User Interface

This chapter gives detailed information on Cantor’s user interface, i.e., how to
use the keyboard and mouse with Cantor.

1. Persistence

Cantor remembers the position and size of all windows, the size and order
of grid columns, which column each grid is sorted on, and the selected printer.
Cantor remembers this information both during a single invocation and between
invocations. To do this, Cantor writes the information to the file Cantor.iniin the
database folder. You can delete the Cantor.inifile if you want Cantor to revert to
the default positions, sizes, etc.

2. Basic Window Operation

The buttons in the top-right of a window’s title bar work just as they do for
other Windows applications to minimize, zoom, or close the window. You can
right-click the title bar or press 〈Alt+Space〉 to activate the Windows system menu.
You can close a window by pressing 〈Alt+F4〉. You can resize a window by dragging
its border with the mouse. A few of Cantor’s windows cannot be resized while
some others can have their width changed, but not their height. (In the latter case,
Windows doesn’t know that the window can only be resized in one dimension and
so will change the mouse cursor if you hover over any of the borders.) You can
maximize a window by double-clicking its title bar and restore it to its previous
size by double-clicking it again. And, of course, you can move a window to a new
position by dragging its title bar with the mouse.

Note that closing a window by 〈Alt+F4〉 or clicking the close button in the title
bar (i.e., the “×” button) is similar to clicking the Cancel or Close button (whichever
the window has). So, if you are currently editing something (e.g., an event or player),
any edits that you’ve made will be discarded. The 〈Esc〉 key is generally the same
as pressing the Cancel or Close button.

3. Scroll Bars

Scroll bars work just as they do for other Windows apps. Click one of the arrow
buttons to scroll one line or column. Click the area between the arrow buttons and
the thumb (i.e., the slider in the middle of the scroll bar) to scroll by one screenful.
Drag the thumb to scroll a variable amount. Scroll bars in grids work slightly
differently; see Section 9 on page 77.
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Figure 1. Window showing disabled and read-only controls

4. Focus

A control is a menu, grid, button, edit field, drop-down list, check box, radio
button, etc. The control that is currently receiving keyboard input is said to have
the focus. The 〈Tab〉 key moves the focus to the next control while 〈Shift+Tab〉
moves the focus to the previous control. Controls generally show that they have the
focus by either some sort of highlighting or by displaying a dotted focus rectangle.
Windows may hide the focus rectangle until you use the keyboard; to turn off this
“feature”, see Section 6 on the facing page.

5. Disabled and Read-Only Controls

Controls can be enabled, disabled, or read-only. When a control is disabled,
its background is the same color as the window and its label is grayed. A con-
trol will be disabled if it doesn’t currently apply. When a control is read-only, its
background is the same color as the window, but its label is displayed normally. A
control will be read-only if it does apply, but you aren’t allowed to change it.

For example, in Figure 1, the Submitted check box is read-only while the Submit
failed check box is disabled (because until an event is submitted, the submission
can’t have failed). The Club field is a bit unusual. It is shown as read-only because
you can’t change it by editing the club’s name, but you can change it by clicking on
the Change button.
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Table 1. Main-window shortcut keys

Action Key

Players
Modify 〈P〉
Copy from Event 〈Y〉
Import 〈O〉
Print 〈T〉

Events
Select Current 〈E〉
Submit 〈S〉

Lists
Import 〈I〉
Browse Rating 〈G〉
Browse Club 〈C〉

Cantor

Exit 〈X〉
Set Up 〈U〉
Set Up Internet
Select Printer
Visit Website 〈B〉
Display Version 〈V〉

6. The Main Menu

The main menu (and Cantor’s only menu) is at the top of Cantor’s main win-
dow. Each menu and submenu item has one letter underlined.

If you don’t see the underlines, then the underlines should appear if you press
〈Alt〉. You can also tell Windows to always show the underlines: In Windows XP,
uncheck Control Panel > Display > Appearance > Effects > Hide underlined letters
for keyboard navigation until I press the Alt key . In Windows Vista and Windows
7, check Control Panel > Ease of Access > Change how your keyboard works >
Underline keyboard shortcuts and access keys. This setting may also affect whether
the focus rectangle is hidden until you use the keyboard.

You can select a menu or submenu item by pressing 〈Alt〉 and the underlined
letter. If the menu has the focus, you can just press the letter without holding
down the 〈Alt〉 key. You can toggle the focus between the menu and the rest of the
main window by pressing 〈Alt〉 or 〈F10〉.

If the menu has the focus, then 〈Left〉 moves to the previous menu item, or if
a submenu is displayed, displays the previous submenu. Similarly, 〈Right〉 moves
to the next menu item or submenu. 〈Up〉 and 〈Down〉move to the previous or next
submenu item. If no submenu is displayed, then they display the submenu. 〈Enter〉
selects the current menu or submenu item. 〈Esc〉 closes a submenu. If no submenu
is open, then it gives the focus back to the rest of the main window.

Most of the submenu items have a single letter to their right. This letter spec-
ifies the shortcut key for the item. You can press the shortcut key to select the
submenu item. For example, there is a “P” next to ::Players > Modify . If you press
〈P〉, it is the same as clicking on Modify . The shortcut keys only work if the main
menu doesn’t have the focus (which is normally the case). Table 1 lists the menu
items and shortcut keys. The underlined letters in the table show how the shortcut
keys were chosen.
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Figure 2. The Modify Result button is the default button

Each submenu has one item in bold. If you double-click a main menu item,
then the submenu item in bold will be selected.

7. Enter Key

Most windows have a default button that will be selected if you press 〈Enter〉
even if the button does not have the focus. For example, in Figure 2, the Modify
Result button is the default button. If there is no default button and the field that
has the focus does not respond to the 〈Enter〉 key, then the 〈Enter〉 key moves the
focus to the next field. If a button has the focus, then the 〈Enter〉 key always clicks
the button.

8. Accelerator Keys

Most labels have an underlined letter. (If you don’t see the underlines, see
Section 6 on the preceding page for how to tell Windows to show them.) You
can press 〈Alt〉 plus the key corresponding to the letter to move the focus to the
associated control. If the control you are moving to is a button, it will also be
clicked. If the control is a check box, it will be toggled (i.e., checked if unchecked
and vice versa). If the control is a radio button, it will be selected. If the control
that has the focus doesn’t respond to letter keys (e.g., a button or an edit field that
only accepts numbers), then you don’t have to hold down the 〈Alt〉 key—just press
the letter key. Note that drop-down lists do respond to letter keys.
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9. Grids

Cantor uses grids to display events, players, clubs, results, and submissions.
You can find grids in the main window and in ::Lists > Rating, ::Events > Select
Current, ::Players > Modify , as well as a few other places.

The selected item in a grid is indicated by a right-pointing arrowhead in the
leftmost column. If the grid has the focus, then the selected item is also high-
lighted.

The scroll bars in grids are standard Windows scroll bars with the following
differences: Click the area between the arrow buttons and the thumb of the hor-
izontal scroll bar to scroll by one screenful minus one column. So, if you scroll
right (say), the last fully visible column on the right before you scroll will be the
column on the left after you scroll. Click the area between the arrow buttons and
the thumb of the vertical scroll bar to move the number of rows in one screenful.
Drag the thumb to move a variable amount.

You can resize or reorder columns by dragging with the mouse. To resize,
drag the vertical line in the header that separates two columns. To reorder, drag
the header for the column to where you want it.

You can sort the grid on a column by clicking the button to the right in the
column header. Not all columns have the button. You can only sort on columns
that do have the button. The column that the grid is currently sorted on will
display a downward-pointing arrowhead in the button. Columns with buttons will
also have an underlined letter in the column header. This indicates the accelerator
key that you can press to sort on the column. These accelerator keys work like
other accelerator keys in that you will have to also press 〈Alt〉 while pressing the
accelerator key if the control that currently has the focus responds to letter keys.
The sort order is decreasing for ratings and increasing for everything else.

In a grid, 〈Up〉moves up one row, 〈Down〉moves down one row, 〈PgUp〉moves
up the number of rows in one screenful, 〈PgDn〉 moves down the number of rows
in one screenful, 〈Ctrl+Home〉 and 〈Ctrl+PgUp〉 scroll to the beginning, 〈Ctrl+End〉
and 〈Ctrl+PgDn〉 scroll to the end, 〈Ctrl+Up〉moves to the first row displayed in the
window, 〈Ctrl+Down〉 moves to the last row displayed in the window, 〈Left〉 scrolls
the display left one grid column. 〈Right〉 scrolls the display right one grid column,
〈Ctrl+Left〉 scrolls the display left one screenful minus one column, 〈Ctrl+Right〉
scrolls the display right one screenful minus one column, 〈Home〉 scrolls all the
way to the left, and 〈End〉 scrolls all the way to the right. Clicking with the mouse
makes the row you clicked the current row.

In the grids on the Browse page of the player or event notebooks, you can
double-click a player or event to switch to the Edit page for the player or event.
In the result grid in the main window, you can double-click a result to modify the
result, i.e., the effect is the same as selecting a result, then clicking the Modify
Result button.

Pressing 〈Ctrl+G〉 sets the focus to the grid. In a Find field, pressing 〈Up〉
moves the focus to the grid.

9.1. Incremental Search. The player, rating list, and club grids have associated
Find fields that let you search for a specific record. These are incremental-search
fields, so you can type just the first part of what you are searching for and the grid
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will move to the first matching record. The search happens after every keystroke.
The value you type must be the sort of thing that is in the column that the grid
is sorted on. For example, if you want to search for a player by name, you must
sort the grid by name by clicking on the button in the header of the grid’s “Name”
column.

10. Drop-Down List

A drop-down list (also called a combo box) is a control that drops down a list of
choices when you click the arrow at the right of the text, e.g., ::Players > Modify >
Edit > State. With the list open or closed, 〈Up〉 and 〈Left〉 select the previous item,
〈Right〉 and 〈Down〉 select the next item, 〈PgUp〉 moves up the number of items in
one screenful, 〈PgDn〉 moves down the number of items in one screenful, 〈Home〉
goes all the way to the first item, 〈End〉 goes all the way to the last item, 〈F4〉,
〈Alt+Down〉, and 〈Alt+Up〉 act as toggles, opening and closing the list, and 〈Esc〉
closes the list without changing the selection from what it was when the list was
opened. With the list open, clicking with the mouse selects an item and 〈Enter〉
closes the list.

With the list either open or closed, you can also select an item by typing it
into the control. For example, to select “VA” you can type “v” or “va”. Similarly,
you can select “2” by typing “2”. In general, the list moves to the first item which
starts with the string you typed. After 1.5 seconds, the control forgets what you’ve
typed, so you can type a new string. You can also press 〈Backspace〉 to clear the
last character you typed.

11. List Box

Cantor uses list boxes to select the winner and loser in the New Result and
Modify Result windows. In a list box, 〈Up〉 selects the previous player, 〈Down〉
selects the next player, 〈PgUp〉 moves up the number of players in one screenful,
〈PgDn〉 moves down the number of players in one screenful, 〈Home〉 goes all the
way to the first player, 〈End〉 goes all the way to the last player. 〈Left〉 tabs to the
previous control, and 〈Right〉 tabs to the next control. Clicking with the mouse
selects a player.

You can also select a player by typing their name into the list box. For example,
to select “James”, you can type “j” or “ja”. In general, the list box moves to the first
player whose name starts with the string you typed. After 1.5 seconds, the list
box forgets what you’ve typed, so you can type a new string. You can also press
〈Backspace〉 to clear the last character you typed.

12. Dates and Date Fields

In grids, Cantor displays dates using the short-date format specified in your
Windows regional settings. You can change these settings in Control Panel > Re-
gional and Language Options.

Cantor has two date fields where you can enter a date: ::Players > Modify >
Edit > Birth and ::Events > Select Current > Edit > Date. For the Birth field, use
the year-month-day order that matches your short-date Windows regional settings.
The (event) Date field displays the month name, but you can still enter the date



15. CHECK BOXES 79

into this field using numbers. However, unlike the Birth field, you must enter the
numbers in this field using the month-day-year order (since the month comes first
when the number is converted to a word).

You can use either a two-digit year or a four-digit year in either date field. For
the Birth field, Cantor assumes that a two-digit year is in the past. For the (event)
Date field, Cantor assumes that two-digit years are between eighty years ago and
twenty years from now.

In either date field, 〈+〉 increments the day, 〈-〉 decrements the day, 〈Up〉 incre-
ments the month, 〈Down〉 decrements the month, 〈Ctrl+Up〉 increments the year,
and 〈Ctrl+Down〉 decrements the year.

12.1. Calendar. You can click the button at the right of the (event) Date field
or press 〈Alt+Down〉 or 〈F4〉 to drop down a calendar. Today’s date will have a
maroon frame around it. You can select today’s date by clicking the Today button.
You can select any date by clicking a day. Click one of the buttons at the top of
the calendar to move to the previous month or next month. If you click one of the
buttons and hold the mouse down, the month will keep changing (and speed up
the longer you hold the mouse down).

You can also select the month by clicking on the header text that displays the
month name. This displays a pop-up menu that lists the months. Select the month
you want by clicking on it or by using the 〈Up〉, 〈Down〉, and 〈Return〉 keys. You
can also select the year by clicking on the header text that displays the year. This
displays two buttons on either side of the year. Click the left button to move to the
previous year and the right button to move to the next year. If you click one of the
buttons and hold the mouse down, the year will keep changing.

As for the keyboard, 〈Left〉 moves to the previous day, 〈Right〉 moves to the
next day, 〈Up〉 moves to the previous week, 〈Down〉 moves to the next week,
〈Home〉 moves to the first day of the month, 〈End〉 moves to the last day of the
month, 〈PgUp〉 moves to the previous month, 〈PgDn〉 moves to the next month,
〈Esc〉 closes the calendar without changing the date, and 〈Return〉 accepts the se-
lected date and closes the calendar.

13. Buttons and Radio Buttons

If a button has the focus, you can click it via either 〈Enter〉 or 〈Space〉. If a
button has an icon, but no text, you can hover the mouse over the button to pop
up a hint that explains what the button does.

In a radio group box, you can use the 〈Up〉, 〈Left〉, 〈Down〉, and 〈Right〉 keys to
change which radio button is selected.

14. Button Edits

A button edit is an edit control that has a button as part of the control to the
right of the edit box, e.g., ::Lists > Import > Rating list. If the button edit has the
focus, you can click the button by pressing 〈Alt+Down〉.

15. Check Boxes

You can toggle a check box by clicking it or, if it has the focus, pressing 〈Space〉.
You can click the box or the text.
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16. Navigator Bar

If a navigator bar (i.e., the bar containing four buttons in the bottom left of
::Events > Select Current > Edit or ::Players > Modify > Edit) has the focus, you
can click the selected button with 〈Space〉 (but not 〈Enter〉) and select a different
button with 〈Left〉 or 〈Right〉. If you hover over a button with the mouse, Cantor
will display a hint that explains what the button does and what shortcut key you
can use to do the same thing.

The shortcut keys are 〈PgUp〉 moves to the previous record, 〈PgDn〉 moves to
the next record, 〈Ctrl+PgUp〉 moves to the first record, and 〈Ctrl+PgDn〉 moves to
the last record. These keys work regardless of which control on the Edit page has
the focus.

17. Notebooks

Notebook tabs can have the focus, just like any other control. If a notebook
tab has the focus, then 〈Up〉, 〈Left〉, and 〈Home〉 change to the first notebook page,
while 〈Down〉, 〈Right〉, and 〈End〉 change to the second notebook page (since all of
Cantor’s notebooks only have two pages).

18. Edit Fields

An edit field is a control into which you type text, numbers, or dates. In an edit
field, 〈Del〉 deletes the character at the caret (the caret is the vertical bar that shows
where you are in the field), 〈Backspace〉 deletes the character to the left of the caret,
〈Left〉 moves left one character, 〈Right〉 moves right one character, 〈Home〉 moves
to the beginning of the field, 〈End〉moves to the end of the field, 〈Ctrl+Left〉moves
left one word, 〈Ctrl+Right〉 moves right one word, 〈Alt+Backspace〉 and 〈Ctrl+Z〉
undo the last change you made, 〈Ctrl+C〉 copies the selected text to the clipboard,
〈Ctrl+X〉 cuts the selected text, 〈Ctrl+V〉 pastes, 〈Shift+Home〉 extends the selection
to the start of the field, 〈Shift+End〉 extends the selection to the end of the field,
〈Shift+Left〉 extends the selection left one character, 〈Shift+Right〉 extends the se-
lection right one character, 〈Ctrl+Shift+Left〉 extends the selection left by one word,
and 〈Ctrl+Shift+Right〉 extends the selection right by one word.

You can also drag with the mouse to select text. If any text is selected, then
whatever you type will replace the selected text and 〈Del〉 and 〈Backspace〉 will
delete the selected text. When you move to an edit field using the keyboard, the
contents is selected, so whatever you type will replace the contents. To edit the
contents, press a key that moves the caret (e.g., 〈Left〉 or 〈End〉) or click with the
mouse to deselect the text.

19. Progress Bars

When Cantor needs to do something that may take some time, it puts up a
progress bar, e.g., Figure 3 on the next page. (For some operations, it doesn’t put
up a progress bar, but does change the cursor to an hourglass.) When Cantor puts
up a progress bar, you can click the Abort button to abort the operation. You can
also abort by pressing 〈Esc〉 or 〈Enter〉. Pressing 〈Alt+F4〉 won’t abort.
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Figure 3. Progress bar





APPENDIX D

Database Folder

This chapter explains how Cantor finds the database folder, how you can move
the folder to a different location after Cantor is installed, and how you can have
more than one event on a given date. There are two ways to tell Cantor where the
database folder is: setting the current folder and using a command-line parameter.

Whenever Windows starts an application, it designates one folder as the cur-
rent folder . When you start Cantor, it looks for the database files in the current
folder. For example, if you double-click on a file with an “exe” extension, then the
current folder will be the folder containing the “exe” file. If you double-click on
a Windows shortcut (e.g., an item on the desktop that has a little arrow on the
bottom left or an item in the “Start” menu), then the current folder is determined
by the shortcut. To see or change the current folder that the shortcut is using,
right-click the shortcut and select Properties. The current folder is the folder listed
in the Start in field.

You may also specify the database folder via a command-line parameter. You
can do this by typing it in a command prompt or bat file or including it in the Target
field in a shortcut’s properties. A command-line parameter takes precedence over
the current folder. You can use the special command-line parameter “appdata” to
have Cantor put the database folder in a subfolder of your application data folder,
e.g., C:\Users\YourUserName\AppData\Roaming\RatingsCentral\Cantor.

Cantor’s installation program puts the “appdata” command-line parameter in
the shortcuts on the desktop and in the “Start” menu. So, you can move the data-
base files to any folder you wish as long as you update the shortcuts by removing
“appdata” from the Target field and setting the Start in field to the new folder.

If you accidentally delete the shortcuts, you can create a shortcut by right-
clicking the desktop and selecting New > Shortcut. This starts the Windows “Cre-
ate Shortcut” wizard. For the “location of the item” (on the first page of the wiz-
ard), enter the path and filename of the Cantor.exe file, e.g., C:\Program Files (x86)
\RatingsCentral\Cantor\Cantor.exe. Click the Next button to go to the second page
of the wizard. For the name of the shortcut, enter the text that you want to ap-
pear as the caption under the desktop icon, e.g., “Cantor”. Click the Finish button.
Right-click the shortcut that you just created on the desktop and select Properties.
Change the Start in folder to the folder where you want to put the database files.

If you need to submit two events on the same date, then you need a second
director ID. If you think that you need to do this, please discuss it with us first; see
http://www.ratingscentral.com/Problems.php for our email address. Also, if you
want to submit events for more than one sport, you need a director ID for each
sport.
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In addition to a second director ID, you need a second set of database files.
Choose a folder for the second set of files, and set up a shortcut for Cantor with
the Start in field set to the second folder. Set the shortcut’s caption to something
that will tell you which set of database files it is using. If you do set up a second
set of database files, be sure that you don’t enter the same director ID into both
sets of files, since this will give you two inconsistent versions of any events that
occur on the same date in both sets.

If you set up a second set of database files, you may wish to set the list database
folder (see Section 2.2 on page 28) to something other than the database folder.
This would let you set both copies of Cantor to use the same list database folder.
So, you would only have to import the lists once rather than twice. However, if you
do this, you won’t be able to run both copies of Cantor at the same time because
only one copy of Cantor can be accessing a folder at a time.
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Crashes and Bugs

If Cantor crashes, you will see a window like Figure 1. If you don’t under-
stand the message, then it may be a bug. You can copy the message and the
details to the clipboard by pressing Ctrl+C. The message and details will also
be in the file CantorCrash.txt in the database folder. There may also be a file
CantorDatabaseError.txt that contains additional error messages.

If you wish to report a bug or have any questions or suggestions, please con-
tact us; see http://www.ratingscentral.com/Problems.php for our email address. If
you are reporting a bug, please include specific steps so that we can reproduce it,
send us the CantorCrash.txt and CantorDatabaseError.txt files, and also send us
the database files (if these will help us reproduce the bug).

The database library that Cantor uses writes all information to a journal file
before updating the database files. After updating the database files, the journal
file is deleted. This should ensure that the files are not corrupted even if the
computer is unplugged in the middle of writing to the files. If this happens, you
may see a file with an n$1 extension in the database folder. This is the journal file.
When you start Cantor, it should process the journal file and delete it.

Most hard disk controllers provide a write-caching feature. If this feature is
on, applications may not be able to force data to be physically written to the disk.
In Windows XP, do Control Panel > System > Hardware > Device Manger. Then
expand the Disk drives node. Right click on the disk-drive controller and choose
Properties > Policies. You will see a check box labeled, Enable write caching on
the disk. Underneath it says, “This setting enables write caching to improve disk
performance, but a power outage or equipment failure might result in data loss or
corruption.” You may wish to uncheck this check box.

Figure 1. Crash window
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〈Ctrl+Shift+Right〉, 80

〈Ctrl+T〉, 45, 48

〈Ctrl+U〉, 45, 48

〈Ctrl+Up〉, 77, 79

〈Ctrl+V〉, 80

〈Ctrl+X〉, 80

〈Ctrl+Z〉, 80

current event, 37, 38, 43, 53

current folder, 83

database folder, 14, 28, 53, 83, 85

Date, 17, 40, 78, 79

default button, 54, 76

〈Del〉, 80

Director, 27

director ID

second, 83

disabled, 74

Discard all, 34

Display Version, 31

〈Down〉, 75, 77–80

drop-down list, 78

duplicate players, 64–66

duplicate record, 34

Edit, 80

Events > Select Current, 39–41

Players > Modify , 44–47, 64

edit field, 80

Email, 46, 63

enabled, 74

〈End〉, 77–80

〈Enter〉, 54, 67, 75, 76, 78–80

error-message window, 67

errors, 67

correcting, see correcting errors

〈Esc〉, 67, 73, 75, 78–80

event

Club, see Club, event

Country , see Country , event

current, see current event

deleting, 39

Match format, see Match format, event

multiple-day, see multiple-day events

Name, see Name, event

State, see State, event

submitting, 41, 63

two on same date, see multiple events on

same date

Event Director Login, 31

Event Director Support, 31

Event.nx1, 14

Events

menu, 37

Select Current, see Select Current

Excel, 34

Existing records, 34

Exit, 27

Expiration, 48

〈F10〉, 75

〈F4〉, 78, 79

Find, 77

club list, 57

Players > Modify , 44

Rating List, 48

rating list, 48

focus, 74, 75

font size, 71

For duplicates, keep. . . , 34

grayed, 74

grid, 17, 38, 43, 73, 77

sorting, 38, 73, 77

hardware requirements, 13

Help, 13

hint, 79

〈Home〉, 77–80

hourglass, 80

hover, 73, 79

ID

new Ratings Central, 64

Ratings Central, 45, 46, 63, 64

TT Australia, 45, 46, 63

USATT , 45, 46, 63

ID

Director, 27

ID list, 50

IDs, 45, 46, 63

Import

Lists, 17, 33, 48

Players, 50

incremental search, 44, 48, 57, 77

installation, 13

journal file, 85

Keep, 34

Last Played, 48

〈Left〉, 75, 77–80

libeay32.dll, 13

License.txt, 13

life membership, 48

list box, 78

List database folder, 28, 49

Lists, 33

log into website, see website login

Loser, 20, 54

main menu, 53, 75

main window, 17, 20, 37, 38, 43, 47, 53, 75, 77
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Match format

event, 40, 63

result, 54

match result, see result

Mean

event unrated prior, 41

player unrated prior, 47, 63

mistakes, 67

Modified, 41, 42

Modify

Players, 17, 43–49, 77

Modify Result, 54, 77, 78

multiple events on same date, 37, 83

multiple-day events, 37

n$1, 85

Name

event, 17, 40

player, 45, 46, 63

Print, 51

navigator bar, 39, 80

Never, 48

New

For duplicates, keep. . . , 34

New personal info, 41, 42, 46, 63

New Player, 48

New Result, 20, 40, 54, 78

No score, 54

notation, 15

notebook tab, 80

nx1, 14

nxTrans.cfg, 14

Old, 34

OpenSSL, 13

Organization, 50

overview, 17–24

Overwrite Player, 48

Password

Director, 28

Email, 29

Web proxy server, 30

personal information, 63

〈PgDn〉, 77–80

〈PgUp〉, 77–80

player

Club, see Club, player

Country , see Country , player

deleting, 44

Name, see Name, player

State, see State, player

player list, 51

Player.nx1, 14

Players, 43

Modify , see Modify , Players

Port, 30

Postal code, 46, 63

Previous Submissions, 42

Print, 47, 51

Print Results, 47, 55

printer, 31

progress bar, 80

Province, 46, 63

quick start, 17

radio button, 76, 79

radio group box, 79

Rating, 46, 47, 63

Lists, 47, 49, 77

Print Lists, 51

Rating List, 18, 44, 47

Rating list

::Lists > Import, 35

rating list, 13, 14, 33, 36, 43, 45, 47, 64, 77

rating-list browser, 18, 36, 44, 45, 47

RatingList.csv, 34

RatingList.nx1, 14, 28

Ratings Central

ID, see ID, Ratings Central

Read-only , 14

read-only, 74

ReadMe.txt, 13

result, 53, 54, 63

deleting, 53

grid, 47, 53–55, 77

Match format, see Match format, result

sorting, 55

window, 54

Result.nx1, 14

〈Return〉, 79

〈Right〉, 75, 77–80

SampleClubList.csv, 13, 17

SampleRatingList.csv, 13, 17

Score, 20, 54

screen resolution, 71

scroll bar, 73, 77

Select Club, 17, 57

Select Current, 17, 37–41, 43, 77

Select Printer, 31

Server name, 30

Set Up, 27

Set Up Internet, 28

Sex, 46, 63

〈Shift+End〉, 80

〈Shift+Home〉, 80

〈Shift+Left〉, 80

〈Shift+Right〉, 80

〈Shift+Tab〉, 74

shortcut key, 45, 48, 75

SMTP port, 29

SMTP server, 28
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sort

grid, see grid, sorting

results, see result, sorting

Source, 48

Source, 33, 35

〈Space〉, 67, 79, 80

Sport, 28

sports

multiple, 28, 83

ssleay32.dll, 13

Standard Deviation

player, 63

Standard deviation

event unrated prior, 41

player, 46, 47

player unrated prior, 47, 63

Start in, 83

State

event, 17, 40

player, 45, 46, 63

Status, 41, 63

Stop Importing, 35, 36

Submission method, 28

Submission.nx1, 14

Submit, 41

Submit Events, 41

Submit failed, 41, 42, 74

Submitted, 42

Submitted, 41, 74

〈Tab〉, 54, 74

Test, 30

thumb, 73, 77

title bar, 73

Today , 17, 79

TT Australia

ID, see ID, TT Australia

two events on same date, see multiple events

on same date

Unrated prior

event, 40, 59

player, 46, 47, 59

〈Up〉, 75, 77–80

Update info from rating list, 49

USATT

ID, see ID, USATT

USATT membership, 48

Use authentication, 29

Use proxy server, 30

Use TLS, 13, 29

user interface, 73–80

persistence, 73

Username

Email, 29

Web proxy server, 30

VersionHistory.txt, 13

Visit Website, 31

website login, 31

window

closing, 73

resizing, 73

Winner, 20, 54

write caching, 85

Your address, 28

Zermelo, Ernst, 69
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